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1. Preliminary Remarks 

 Only instructed users may work on the TEM.  

 This quick guide is intended as a quick reference for trained users. Press F1 to access the Online 

Help on the TEM computer. 

 The instructions on occupational safety must be fully understood.  

 Please do not eat or drink at the TEM (it is ok in the anteroom). 

  

 

 

 

 

 Things that can be damaged most quickly on the TEM due to incorrect operation: 

 Bending the holder - Therefore, always handle the holder carefully and never with force. 

 Vacuum collapse on the FEG - Therefore, always keep Column Valves closed when chang-
ing anything on the vacuum system.  

 Red light on the Compustage means: Never insert or remove a specimen holder in the 
Compustage.  

 Damage scintillator on camera due to too much beam power - Therefore, double check 
that the shield is closed when switching to Diffraction Mode.     

2. Occupational Safety 

 X-ray protection: The initial briefing for LNQE equipment subject to radiation or X-ray protection is 
carried out by the technical manager. Thereafter, the instruction must be refreshed to the day at the 
latest. These briefings are then possible online. 

 Liquid nitrogen LN2: briefing by Fritz Schulze-Wischeler. The hazards are: Cold burns, lack of oxygen 
due to displacement, explosion hazard for closed containers, O2 accumulation on cold surfaces. => 
Wear protective cryogenic gloves and goggles when filling.          

 SF6: There is SF6 in the TEM at the FEG and in the equipment room. SF6 has two hazards:         

 Risk of suffocation: If it escapes, it displaces oxygen and there is a risk of suffocation (SF6 is 
heavier than air). 

 Fluorine poisoning: SF6 decomposes to sulfur and fluorine at over 250 °C, releasing highly re-
active fluorine. Fluorine is very toxic.    

 In case of emergency: In case of fire or other emergency situation (building evacuation), press the OFF 
key on the System On/Off panel. The microscope will shut down, minimizing any danger to persons in 
its vicinity or to yourself. Switch off the TEM PC. Immediately leave the room with the microscope. 
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TEM Bright Field 

3. Starting the Session 

 Check that the HT and Vac switches on the control panel are illuminated  
This only works if the room light is on. If not both control lamps are lit, do not continue, but con-
tact the TEM instrument officer. 

 
 

 Log in to the computer in the anteroom and check the asset ledger 
Logging into the LNQE domain. In the "TEM" group drive, the asset ledger " Anlagenbuch TEM FEI 
Tecnai F20.XLS" is located in the main directory. Check here (especially the "Special" column) in 
which state the TEM is currently is. 
  

 Log in to the TEM computer and start control programs 

1. log in with the individual user name. 

2. start programs (in this order): 

1. TEM User interface 

2. digital micrograph (wait a while until the menus are loaded) 
3. TIA 
 

 Check whether "Column Valves" are closed, HT and FEG are on   
 

 
 
 
 

Select "Setup" tab 

 Status: COL. VALVES must be RED 

 Col. Valves Closed must be YELLOW 

 High Tension always be YELLOW  
(i.e. high voltage always on) and set to 200 kV 
 
If HT has failed: contact the TEM instrument 
officer!!! 

The FEG should always run and therefore 
Operate should always be YELLOW  
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 Transfer important values to the asset ledger. 

 
 

 Check apertures  
C2 to 4 for TEM, Objective & Selected Area aperture out 
 

 
 
 
 
 
 
 
 

 Check Compustage 

The Compustage must be in the zero position, i.e. X, Y, Z and α, ß must all be approximately 0.  
If this is not fulfilled, then a Holder reset must be performed (see under "Ending the session").     

 

Condenser Aperture 1 (C1, always at position 4) 

Condenser Aperture 2 (C2 always on position 3). 

Objective Aperture  

Selected Area Aperture 

Aperture is: 
 

Inside 
 

Out 

Write the vacuum values in the asset 
ledger.  

Write the FEG emission current in the as-
set ledger. If the current has changed 
significantly from the last session, con-
tact the TEM instrument officer.    
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 Fill liquid nitrogen 

1. Cover the viewing screen on the TEM with the rubber cover.  

2. Put on protective goggles and gloves.  

3. Carefully fill the cold trap on the TEM to approx. 1 cm below the edge.  

4. After approx. 10 minutes, you can load the trap.  
 

 Open vacuum overview 
(At the bottom right of the screen) 
 
 
 
 

 
 

 
 

The different values represent logarithmic values of pressures.  
 
IGP = Ion getter pump 
Pen = Penning vacuum gauge 
Pir = Pirani vacuum gauge 

Open the vacuum overview here 

IGP2 and IGP3 are the FEG 
vacuum (IGP2 must be 1) 

IGP1 is the column vacuum 
(must be 6 if ideally pumped 
down) 

V7 + V4 closed correspond 
to the "Column Valves: 
Closed" state 

P3 is the vacuum at the cam-
era 
 
P1 is the vacuum at the 
buffer tank 
 
P2 is the backing line vacuum 
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4. Place the specimen in the single-tilt specimen holder 

 

 
 

 The brass-colored part between the O-ring and the head end of the holder must never be touched 

with the hand or other parts that are not suitable for vacuum. wear protective gloves if necessary.  

 Press lightly against the black end of the holder with one hand to prevent it from slipping out of 

the protective tube.    

 Insert the tool (located in the holder, see illustration) into the hole at the head end of the clamp. 

Then carefully and without force, lift the clamp straight up until it is at right angles to the holder 

(see photo). 

 Place the specimen as centered as possible in the circular depression of the tip of the specimen 

holder. Lift the sample with the small sample suction pump as close to the edge as possible (or 

alternatively with tweezers). For TEM & STEM, the sample should be placed around so that the 

material to be microscoped is now facing down. When mounting in the TEM, the sample holder is 

rotated 180° so that the material is now facing upwards.         

 Lower the clamp with the tool carefully and without force straight down onto the sample. Guide 

the clamp during this process and do not allow it to snap. Make sure that the specimen remains 

correctly in position. The spring in the specimen holder presses the clamp against the specimen, 

so it is not necessary to press it yourself. Put the tool back into the holder.  

 Gently pull the holder out of the protective tube and rotate the holder 180° so that the specimen 

is facing down. Tap the black end of the holder a few times. Turn the holder back and check that 

the specimen has not moved (movement is an indication that it was not properly inserted and 

clamped). 

 Pull the holder out of the protective tube and inspect the O-ring closely for dirt, hair, etc. under 

the magnifying glass. Dirt can be carefully removed with a tweezer or toothpick.  

 If the O-ring has become too dry: Never grease the O-ring independently, but contact the TEM 

instrument officer. 

Tool holder         Tool at the clamp 

Here comes the sample in 
(Ø Sample = 3,05 mm)   
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5. Insert specimen holder into the Compustage 

 Touch the Selected Area control once with your left hand to discharge any static charges. Now 

stand still.   

 Carefully insert the specimen holder into the compustage with the small pin near the holder tip at 

the 5 o'clock position so that it fits into the small notch inside the compustage.  

 Alternatively: Carefully insert the specimen holder with pin at 6 o'clock position until you feel a 

resistance at the end. Then turn to 5 o'clock so that the specimen holder can be inserted all the 

way in. (Here the warning light is on briefly - this is ok and normal).     

 The pump starts automatically and evacuates the Compustage. The red warning lamp is on: Do 

not move the specimen holder! The Single-Tilt-Holder can be released carefully. The double-tilt 

holder should be held carefully for the entire pumping time.   

 The respective holder (single or double) must be selected on the control interface on the PC and 

confirmed with the small arrow button ↵. 
 

 
 
 

 
 

 For Double-Tilt only: Connect the cable from the holder to the Compustage. The cable must not 
block later or touch the protective cap (otherwise vibrations will be coupled in).     

 
 

 
 
 
 
 
 
 
 
 
 
 

5 o'clock position 

12 o'clock position 

6 o'clock position 

Warning light: 
If on, then do not 
move sample 
holder 



Quick Guide for TEM, Laboratory of Nano and Quantum Engineering, Leibniz University Hannover 

Page 8/47 

 
 

 The remaining pumping time is displayed at the bottom of the vacuum override (180 seconds). 

(Experienced users set "save numbered" in Digital Micrograph during this time).  

 When the pumping time is over, the pump will stop and the red warning light will go off.  

 Then the sample holder should be inserted completely: with the left hand press lightly against the 

purple surface on the Compustage and with the right hand turn the sample holder carefully coun-

terclockwise so that the inner pin comes to the 12 o'clock position. The large pin visible on the 

outside, near the black end of the holder, is thus moved to the 6 o'clock position. This "unlocks" 

the Compustage. Caution: The vacuum pulls the specimen holder in! Therefore, hold it firmly!  

 Slowly slide the specimen holder in to the end. The large pin disappears into the shaft at 6 o'clock. 

Check whether the specimen grip is completely in.     

 Knock loosely against the end of the specimen holder a few times. 

 Attach the large gray protective cap.   
 
 
 



Quick Guide for TEM, Laboratory of Nano and Quantum Engineering, Leibniz University Hannover 

Page 9/47 

6. Control Panel 

 
Left Control Panel = LPC 

 
 

 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Right Control Panel = RPC 
 
 
 
 
 

 
 

 
 
 
 
 

α – Tilt  
(Rotate the specimen 
holder around the α-
axis, which runs along 
the longitudinal axis of 
the specimen bar) 

ß – Tilt  
(Rotate specimen 
holder around the ß-
axis. Only with dou-
ble-tilt holder)  

track ball to change the beam 
position. Above this are the 
associated fine/coarse con-
trols   

Intensity to change the beam diame-
ter. Above this are the associated 
fine/coarse controls. Work is per-
formed with a slight overfocus -> 
turned up in a clockwise direction   

Stigmator on/off.         
The different stigmators 
are selected on the PC 
interface 

Multifunction control-
ler X.  
Above this are the as-
sociated fine/coarse 
controls 

Left multifunction 
knobs L1, L2 and L3 

Right multifunction 
knobs R1, R2 and R3 
(On R1 is mostly 
"open/close screen") 

Multifunction controller Y  
The associated 
fine/coarse controllers 
are on the LCP above 
multifunction controller X 

Magnification 
In TEM mode, this sets the magnification. In 
Diffraction Mode, this changes the camera 
length 

Focus: The inner knob is used 
to adjust the focus and the 
outer ring is used to change the 
focus step 

Darkfield:  
Switches between 
Darkfield (light on) and 
normal Bright Field 

Diffraction  
Switches between dif-
fraction (light on) and 
normal image 

Wobbler On/Off. 
This is the Focus 
wobbler 

Eucentric Focus  

Joystick: Compustage 
X-Y movement. Above 
this are the associated 
fine/coarse controls 
 

Z-axes of the 
Compustage. The 
movement speed 
depends on the 
pressure 
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7. Alignements  

 Darken 
Usually the light is off when microscoping. With the dimmer (to the right of the TEM) you can 
make yourself some dim light.    

 Open Column Valves  
The phosphorescent screen in the TEM must be closed. When the pressure in Column IGP1 is ≤ 
15, the Colum Valves may be opened. The pressure should continue to drop to 6. If the pressure 
does not reach 20 or 6, then the sample holder should be ejected again and the O-ring inspected 
for dirt.  

 Load FEG-Registers (Optional) 
If the beam alignment looks very bad, then an older, known FEG register for TEM mode should be 
loaded. Or of course, if you want to change the mode (TEM, STEM, tomography). To do this, open 
Setup -> FEG Registers, see figure. Select a register and press Set to load it. The TEM will continue 
to work with the individual settings of each user where they finished the last session. So if you 
continue to work in the same mode, then loading new FEG registers should be the exception.     

 

 
 

 Control Spotzise 
At this point you should check whether Spotsize = 3 (for TEM mode) is set (otherwise change it). 
Without specimen holder, the TEM automatically switches to Spotsize = 5 for safety reasons.   
 

 
 

 Find the beam 

 Often the beam is on the grid of the sample -> move joystics a bit (change xy-position). This 

almost always works. Otherwise you can still try:   

 The magnification is too large -> set to 4400 x to 1500 x 

 The beam brightness is very far away from the focus point -> change the intensity at the LCP  

 Maybe the beam is not directed to the center of the screen -> make magnification very small 

and change the position with the trackball at the LPC 

 If nothing works: Load another FEG register.  

 

 Condenser Aperture C2 centered  

 For TEM mode, C2 is set to 3.  

 Increase magnification slightly, at least 44,000 x. 

 Use Intensity on the LCP to focus the beam to a small spot. 

 Use the trackball on the LCP to center the spot beam absolutely on the phosphorescent 
screen. 
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Faster method    

 Then wind the beam fully clockwise with Intensity so that almost the entire screen is illumi-

nated.    

 Use the X and Y adjustment knobs of the aperture to adjust it so that the expanded beam is 

as centered as possible. The four outer markings on the phosphorescent screen can be used 

as a guide.  

 The whole procedure is iteratively repeated until the beam remains centered and uniformly 
wound (both clockwise and counterclockwise).   

 More accurate method  

 Then pull up the beam with Intensity clockwise until the 4 cm ring on the screen is illumi-

nated.  

 Place the trackball exactly on the 4 cm ring.  

 Now move Intensity into subfocus (counterclockwise) and illuminate the 4 cm ring again. The 

difference between the 4 cm ring and the round beam is the misalignment. 

 Now using the X and Y adjustment knobs, adjust the aperture so that the beam is slightly bet-

ter to the 4 cm ring (but not perfect).  

 And back to overfocus with Intensity and see how well it fits now. 

 Repeat the whole procedure iteratively until the beam stays centered and winds up uniformly 

(both clockwise and counterclockwise).  

 

 Set eucentric height  
There are several methods, all of which should be mastered. Preferably, the sample is always 
shifted in the z-direction so that it is at the eucentric height (rather than shifting the focus to the 
sample). This, among other things, makes the calibration of the scale display most accurate, since 
all base alignments of the TEM were made for the eucentric height.              

 
Method: Minimum contrast  

 Press Eucentric Focus on the RCP. This sets the focus for the eucentric height defined 

in the base alignments of the instrument. 

 Set a magnification of 30,000 - 50,000 x. 

 Searching for a specimen detail 

 Use the z-axis buttons on the RCP to move the specimen up and down so that the 

specimen detail has minimal contrast. 
 
Method: Minimum scattering  

 Press Eucentric Focus on the RCP.  

 Set a magnification of 30.000 - 50.000 x. 

 Find a sample detail. Collections of amorphous material are best.  

 Condense the beam to a point using Intensity on the LCP.  

 Use the z-axis buttons on the RCP to move the specimen up and down so that the 

scattering around the central bright spot is minimized.  
 

X and Y adjust-
ment knobs for 
the aperture 

Dial for the size of the aper-
ture (TEM: position 4) 

The phosphorescent screen in 
the TEM (sketch) 

4 cm ring 
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Method: focus wobbler  

 Press Eucentric Focus on the RCP.  

 Set a magnification of 30,000 - 50,000 x. (Also depends strongly on the size of the 

specimen detail).  

 Search for a specimen detail. 

 Now fix the sample detail well with the eyes and start the focus wobbler with the 

"Wobbler" button on the RCP. This will cause the beam to wobble around the speci-

men (similar to the α-wobbler where the specimen wobbles in the fixed beam - the 

relative motion is the same).  

 Amplitude and spatial direction of the wobble can be changed with the two multi-

function controllers.  

 Wobbling produces two superimposed images of the sample. Use the z-axis buttons 

on the RCP to move the specimen up and down so that the two images overlap 

again. If necessary, correct with the joystick so that the specimen detail does not 

move out of the image. 

 If the eucentric height is correct, then you can set the wobbler amplitude both high 
and low without changing the image. Turn the wobbler off again.     

 
Method: α–Wobbler 

 Press Eucentric Focus on the RCP.  

 Set a magnification of 30,000 - 50,000 x. (This also depends on the size of the speci-

men detail).  

 Find a sample detail and move it to the center of the screen.  

 Now start the α-wobbler. This causes the specimen holder to tilt periodically about 

the α-axis. The α-wobbler can be controlled either via one of the multifunction keys 

L1 or via the user interface of the Compustage (see figure). There you can also set 

the amplitude, e.g. to 5. 
 

 
     

 The z-axis buttons on the RCP are used to move the specimen up and down so that 

the movement of the specimen detail is minimized. 

 When the movement of the specimen detail is minimal, then one is in focus and the 
α-wobbler can be issued.   
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 Alignment: Gun Tilt (Optional) 
Gun Tilt and Gun Shift only need to be redone if the 
beam intensity has become too weak. Typical values 
for the Screen Curent ~10 nA and Exposure Time ~ 
0.5 s. 

 Set typical magnification, e.g. 44,000 x 

 Illuminate the 4 cm ring (wound up clockwise) 

 Click Alignments -> Direct Alignments -> Gun Tilt.  

 Now use the two multifunction controls to move 
the beam back and forth so that the Exposure 
Time is set to minimum. If necessary, use the trackball to bring the beam back to the 
center. 

 End with Done.  
 

 
 

 
 

 Alignment: Gun Shift (Optional) 
Gun Tilt and Gun Shift only need to be redone if the beam intensity has become too weak.   

 Set a typical magnification, e.g. 44.000 x. 

If the spot moves out of the field of view, 

start with a smaller magnification. 

 Set Spot Size to 9 with R3.  

 Use Intensity to contract the beam and 
center it with the trackball. 

 Set Spotsize to 3 with L3. (Now it is no 

longer in the center if Gun Shift is not 

ideal). 

 Click Gun Shift in the Direct Alignments. 

 Spot the beam with Intensity and center it with the two multifunc-

tion sliders.  

 Press Done when done.  

 Repeat the last steps iteratively until the beam stops moving when 

the Spotsize is changed from 9 to 3.   

 When Exposure Time has increased again, then readjust Gun Tilt 

again. 

 If necessary, correct the astigmatism of the Condenser Lens again.  
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 Alignment: Astigmatismus der Condenser Lens  

 If the beam on the phosphorescent screen is not 

round, the astigmatism of the Condenser Lens 

must be corrected. 

 Press the stigmator on the LCP. 

 The correct stigmator (here: Condenser) must 

be selected on the PC interface. The menu is at 

Alignments -> Stigmator.  

 With the two multifunctional controllers, the 

beam can now easily be brought into a round 

shape. The easiest way is to orientate at the 4 cm ring on the phosphorescent screen.   

 Finally, press Stigmator again to turn off the control. 

 

 Alignment: Pivot Points 

 Set typical magnification, e.g. 175,000 x 

 Use Intensity to constrict the beam to a point 
and center it with the trackball. 

 Click on Beam tilt pp X. The beam now wobbles 
back and forth. 

 Adjust the beam with the two multifunction con-
trols so that it has a bright point in the center 
around which the beam wobbles (see illustra-
tion).  

 Press Done when done.  

 Do the same for Beam tilt pp Y.  

 
 
 

 Alignment: Beam Shift 

 Set the typical magnification, e.g. 175,000 x. 

 Use Intensity to contract the beam to a point 

and center it with the trackball. 

 Press Beam Shift. The beam now moves to the 

side. If it disappears from the field of view, re-

duce the magnification until you find it again.  

 Center the beam with the two multifunction 

controls.  

 Press Done when finished. 

 

 

 

 

 

Pivot Points: Correct   Pivot Points: Wrong   Pivot Points: Wrong  
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 Alignment: Rotation Center 

 Set the typical magnification, e.g. 175,000 x. 

 Use Intensity to contract the beam to a point and 

center it with the trackball. 

 Press Rotation Center. The beam now begins to 

oscillate. Use the ring on the focus control to 

change the amplitude of the oscillation.  

 With the two multifunction knobs you can influ-
ence the movement of the beam. It should be ad-
justed so that it oscillates in the center (and not 
back and forth), see figure. 

 Press Done when finished.  

 If Rotation Center is set, then briefly check Beam Shift and Rotation center again, since the 
alignments influence each other.   

 
 
 
 
 

 
 
 
 
 
 
 
 

 Alignment: Coma-Free (Optional) 
Only necessary at maximum resolution for best images. Coma-Free Alignment and Rotation Cen-
ter influence exactly the same beam parameters - only the adjustment method is different.     

 Set Magnification very large, 440,000 x 

 Place a sample detail in the center of the screen and pull the beam wide open with the 

Intensity. 

 Now press Coma-Free Alignment X. This will cause the beam to start bouncing back 

and forth. The beam should be pulled up so far that the specimen detail always re-

mains visible.   

 Now use the multifunction knob on the LPC to focus the specimen detail as it jumps 

back and forth. The best way to see this is in Digital Micrograph in the FFT. The sample 

detail itself will look slightly different as it bounces back and forth, because the beam 

is shining through it in different ways.    

 The same for Coma-Free Alignment Y. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rotation Center: Correct   
The beam oscillates 

around a bright spot in 
the center 

Rotation Center: Wrong 
The beam oscillates 

around a bright point at 
the edge 

Rotation Center: Quite wrong  
The beam oscillates back and forth 

so much that a dumbbell-shaped im-
age is created 
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 Alignment: Astigmatism of the Objective Lens 
This alignment is made with the support of FFT in Digital Micrograph. 

 Holding down the ALT key will bring up a dotted square on the live image. (Start far left at the 

top and then drag it up).    

 Then the Fast Fourier Transform is taken from it.  

 Process -> Live -> Reduced FFT 
 

 
 
 

 In the live image of the FFT you can see circles if the eucentric height is not set quite cor-

rectly. 

 Now you can adjust the eucentric height ideally with z-axis at the RCP. Then the image is well 

illuminated in the FFT. 

 Then use the focus knob to go back to subfocus a bit to see the circles in the FFT.   
 

   
Correct: Round circles 
 

Wrong: Not round Wrong: Instead of round circles 
can come to such patterns 

 If the circles in the FFT are oval, then the astigmatism of the objective lens must be corrected. 

To do this, press the stigmator on the LCP. If the astigmatism is very strong, the objective lens 

aperture is probably not set well (correct again if necessary).  

 The correct stigmator (here: Objective) must be selected on the PC interface. The menu is at 

Alignements -> Stigmator. By default, the Objective stigmator is already selected when the 

Stigmator button is pressed.  

 Now use the two multifunction controls to make the circles as round as possible. Sometimes 

it is helpful to place a circle from the upper menu in the FFT image to see exactly when the 

circles are round.     

 Finally, press Stigmator again to make out the control.  

 Use the focus button to go back into focus. 

Select a dotted 
square and hold 

down the ALT key 
to select a square 

area.

Then start the Re-
duced FFT from it
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8. Measuring with Digital Micrograph 

 

 Save images:  

 With "Save Numbered" you only have to enter the sample designation and the date once. Each 
time you save, the images are automatically labeled and assigned a sequential number.  

 
 
 
 
 
 
 
 

 File -> Global - File -> Global Info -> Saving -> Save Numbered 

 Then specify there:  

 The path where it should be saved (please, the own directory).  

 The string that should identify the files. Typically sample name + date.  

 Set Next Index to 1.  

 Save as Gatan Format.  

 Confirm with OK. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NEW: Save to 
"TEM Bilder" on 

the user directory
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  Capture images:  

 The beam should illuminate the 4 cm circle well.      
 
 
 
 
 
 
 
 

 Open the phosphorescent screen so that the electron beam 
falls on the CCD camera. To do this, press either R1 on the RCP 
or the mechanical button directly on the left of the TEM. 

 
 
 
 
 
 
 

 With the "Start/Stop View" button in the right menu the cam-
era takes live pictures in fast search mode. (If the camera is still retracted at the beginning, DM 
asks if you want to extend the camera: Yes). 

 Camera modes: 

 Search: Lower resolution (with binning 2) with fast repetition rate for real-time images. 

 Preview: Higher resolution with medium repetition rate. 

 Acquire: Acquire the image with the set exposure time.  

 A dotted square is placed on the live image. To do this, select the corresponding symbol in the 
menu, hold down the ALT key, click in the upper left corner of the image and then drag to the 
lower right. Then the Fast Fourier Transform is created from it. Under Process ->Live -> Reduced 
FFT. The FFT is used to control focus and astigmatism (see Alignments). 

 Normally you only need Search and Acquire mode. Both are set to the same 2004 x 1336 field, 
where Search works with 0.1 seconds and binning 2, Acquire with binning 1. You can check this by 
pressing the small tool icon.    

 Normally you only set the exposure time e.g. 1 second.     
 

Mechanical button 
for lift screen
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9. Contrast Aperture 

A better contrast is obtained with the objective aperture as the contrast aperture. However, 
an aperture also limits the maximum resolving power that can be achieved. Typical values: 
At 50,000 x aperture 2, at high resolution 350,000 x aperture 4 or no aperture. 

 The phosphorescent screen must be closed. Otherwise the scintillator of the camera 
may be damaged! The objective aperture is still out.   

 The sample site that is currently visible in the TEM will be strongly irradiated in the next 
step. It is therefore advisable to move the joystick slightly to the side to avoid damaging 
the area of interest.  

 Diffraction button on the RCP. This now maps the intermediate image plane of the 
Objective Lens onto the phosphorescent screen. The spot in the center is very bright. 
The "Magnification" button is used to set the camera length in Diffraction Mode; set 
460 mm here. The spot in the center can be adjusted with the two multifunction 
controls.  
 
 
 
 
 
 
 
 
 
 
 

 Now use the control dial to set the aperture size and bring in the aperture (lever to the 
left).   

 Using the two x and y adjustment knobs on the aperture, the aperture must now be 
set so that the direct beam passes through as centrally as possible.  

 For aperture 1-2, the apertures are very narrow compared to the beam. Therefore, it is 
best to move the small auxiliary screen in with the lever on the left of the TEM and 
look at the beam through the optical microscope when adjusting the aperture.  

 Finally, press the Diffraction button again and return to Bright Field.  
 
 
 
 

Dial for aperture 
size

Lever for inserting 
and removing the 

aperture

x and y  
Adjustment 
knobs

Lever for auxiliary screen 
on left side of TEM 

Auxiliary screen Optical microscope 
for adjustment 
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10. Ending the Session 

 Set magnification to SA 4400 x and illuminate 4 cm circle on screen 
 

 Drive Compustage to the center  
First move the joystick to the center, then the rest can be 
done with Compusage -> Stage2 Flapout -> Reset: Holder.  

 

 Take out objective & SA apertures 
I. e. both levers to the right. 

 

 Close Column Valves 
 
 
 
 
 
 
 
 
 
 
 

 

 Stop camera and move back 
"Stop View" and uncheck "Camera Inserted" in Digital Micrograph. 
 

 

 Remove the sample holder from the Compustage 

 Remove the cover of the Compustage.  

 Touch the Selected Area aperture control once with your left hand to dis-
charge any static charges. Now stand still. 

 Then press against the purple surface on the Compustage with your left 
hand. This is important, otherwise the Compustage can be damaged when 
the sample holder is pulled out.  

 Carefully pull out the sample holder until you feel a slight resistance. Then turn the sample holder 
clockwise by about 180° until it stops moving. This " closes" the compustage. 

 For the double tilt holder: Disconnect cable connection.   

 Now carefully pull out the sample holder against the resistance. Stabilise with your left hand. At a 
certain point it is very easy. Then do not hit the sample holder against the opening.   

 If the red warning light is still illuminated on the Compustage: Select "no holder" on the control in-
terface on the PC and confirm with the small arrow button. 

  Finally, fit the cover of the Compustage.   
 

 Remove sample 

 The part between the O-ring and the head end of the holder must never be touched by hand or 

other non-vacuum-compatible parts. Wear protective gloves if necessary.  

 Return the sample holder to the holding device.    

 Insert the tool into the hole at the head end of the clamp. Then carefully lift the clamp straight up 

without force until it is at right angles to the holder. 

 Remove the sample. Trick: Turn the sample holder and drop the sample directly into the sample box.         

 Close the clamp again. 

 

 

 

 

 

 

Reset Holder
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 Refit the empty sample holder in the Compustage 

 This keeps the holder clean and reduces the amount of dirt that gets into the Compustage 

 Finally, slide the protective cap onto the holder.   

 

 

 Set FEG to 4500 V (if nobody wants to measure afterwards) 
 
 
 

 Pour back the remains of liquid nitrogen (if nobody wants to measure afterwards) 

 Cover the viewing screen on the TEM with the rubber cover. 

 Put on safety goggles and protective gloves. 

 Pour the remainder of the cold trap and the transfer container back into the large nitrogen con-
tainer.  

  The cold trap and the transfer container are placed upside down in the polystyrene device so that 
condensation can drop out of the containers.   

 Place a paper towel where the cold trap was on the TEM to collect condensation water.   
 

 Start Cryo Cycle (if nobody wants to measure afterwards) 
1. Setup –Flapout > Cryo ->Press Cryo Cycle. 
2. the Cryo Cycle starts automatically after 7 minutes. The TEM user interface can be 

closed, the programme for the Cryo Cycle continues to run in the background.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 Exit the three programmes (File -> Exit) 
 

 Log out of the TEM control computer (DO NOT shut down), switch off the monitors 

 Attention: A short waiting time (at least 10 seconds) should be observed between closing 
the three programmes and logging out so that all programmes are really closed. 

 Attention: Sometimes the TEM control computer freezes or crashes immediately after 
logging out. Then inform the TEM instrument officer.     

 

 Move data 
Data from TEM Bilder:\Nutzer\Username move to TEM:\Nutzer Verzeichnisse\Username.  
 
 
 
 
 
 
 
 
 
 

7
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 Batch Convert of the DM3-Data 
The images are in DM3 format and each 42 MB in size. They can be edited with Digial Micrograph 
or with the freeware imageJ. To convert the images in Digital Micrograph into common formats: 
File -> Batch Convert. Then select the folder where the images are saved and select the format to 
which you want to convert (BMP, JPEG or TIFF). Confirm with OK and the converted images will be 
created in the same folder.  

 
   

 Make any final entries in the logbook and shut down the computer in the anteroom (if nobody wants to 
measure afterwards) 

 

 Clean up!  
The laboratory should be left at least as tidy and clean as you found it.  
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TEM other Modes 

11. Dark-Field Imaging  

Im normalen TEM-Modus (bright field, BF) wird der direkte Strahl (direct beam) aufgenommen, im Dunkelfeld-

Modus (dark field, DF) wird ein Teil des gestreuten/gebeugten Elektronenstrahls aufgenommen, wobei der di-

rekt beam mit der Objektiv-Blende abgeblendet wird. Daher geht DF-Imaging mit dieser Methode nur, wo auch 

eine Objektiv-Blende eingesetzt werden kann (d. h. im SA-Mode z. B. bei 50,000 x Maginification). Bei zu hohen 

Magnifications würde eine Blende die Auflösung beschränken.   

 Probe wie im normalen TEM-Modus einbauen, C2 einstellen, Euzentrische Höhe einstellen, direkt 

Alignements durchführen.  

 Z. B. 50,000 x Magification. Objektivblende auf 2 einbauen (siehe Alignement: Objective 

Aperture). Hierbei sollte der zentrale Strahl immer ideal mittig auf den Schirm kommen (ggf. mit 

den Multifunktionsreglern nachregeln).  

 Jetzt wieder im BF-Mode und die Blende rausnehmen.   

 Der Schirm ist geschlossen! Diffraction-Knopf am RPC Drücken. Jetzt hat man in der Mitte einen 

direct beam (hellen Punkt) und darum herum die gestreuten/gebeugten Strahlen. Camera length 

auf 650 mm (mit dem Magnification-Knopf einzustellen). Darkfield-Knopf am RPC drücken und mit 

den beiden Multifunktionsreglern den gewünschten Ring oder gebeugten Strahl in die Mitte brin-

gen. Der helle direct beam ist dann nicht mehr mittig. Mit dem Darkfield-Knopf kann zwischen 

diesen beiden Positionen gewechselt werden. Objektiv-Blende wieder reinschieben und testen. 

Jetzt sollte mal nur der direkt Beam und mal nur der selektierte Ring durchscheinen.  

 Difraction drücken und so zurück im bright field wechseln.  

 Schirm aufmachen und das bright field image mit Digital Micrograph sichtbar machen. Bild der 
gewünschten Probenstelle aufnehmen (im bright field). Darkfield-Knopf drücken und die gleiche 
Stelle aufnehmen. Meist muss die Exposure Time erhöht werden (z. B. von 0.2 s auf 1 s oder hö-
her), um ein scharfes Bild zu erhalten.  
 
 

  
Exemplarische Nanopartikel gemessen in bright field-modus (links) und die gleiche Probenstelle in 
Darkfield-Modus (rechts) 
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12. Selected Area Diffraction 

The diffraction mode images the back focal plane onto the screen or detector. The diffraction pattern is an im-
age of the electrodes diffracted and scattered in the sample. ATTENTION: The single points (especially the point 
in the center) of the diffraction pattern can become very intense and thus damage the scintillator of the CCD 
camera! Therefore:   

 This imaging mode is only allowed for specially trained users! 

  always work with the utmost caution!   
 

 Mount sample and insert (for crystalline samples take double tilt holder if necessary, if α AND ß are to 
be tilted). 

 For double tilt holder: Sample, washer, conical ring. First turn a little counterclockwise so that you find 
the place where the thread goes in, then turn clockwise very carefully without force a little pure and 
"butter soft" only tighten. It must be flush (look at it from the side). For cross section specimens: In-
stall the adhesive edge perpendicular to the rod.  

 Mount specimen as in normal TEM mode (bright field), set C1, set eucentric height, perform align-
ments directly.  

 Align specimen with α and ß: Press Diffraction (screen must be closed, of course!).  In the image, if the 
sample is thick enough, you can also see Kikuchi lines. Then tilt with α and ß, so that in the pole.  Fi-
nally press Diffraction to go back to bright field. 

 

    

DP with Kikuchi lines.                                    By tilting, the sample is now in the pole.   

The photos show the 111 direction of silicon. 

  

Examples of Kikuchi lines in various materials can be found in Wiliams Carter Volume 2 (available in 
the TEM anteroom). Diffraction patterns and Kikuchi lines for various materials can be calculated 
online at:  http://emaps.mrl.uiuc.edu/  

 Bring the interesting specimen detail to the center. Set the selected area aperture (lowest aperture), 
set the aperture size (usually no. 2 or even 1) and center it with the two sliders. 

 Screen closed to protect camera! Now press the Diffraction button on the RPC. Now the rear focal 
plane is imaged. 

 Use the multifunction knobs to center the centrally transmitted beam. Use the magni-fication knob to 
set the camera length, which corresponds to magnification in this figure (typically: 285 or 460 mm).  

 Spread the beam with the "Intensity" control on the LPC until the pattern shows rings, ideally with 
dots for crystalline samples.  

 Focus the diffraction pattern with the focus button RCP. If necessary, you can also see this well with 
the light microscope on the auxiliary screen 

 
 
 
 
 
 
 
 
 
 

http://emaps.mrl.uiuc.edu/
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 Bring in beam stopper so that the central spot is blocked. This is very important to protect the camera! 
 

 

 

 Possibly readjust the central spot with the multifunction controllers so that it is blocked by the 
beam stopper. 

 In the following: DO NOT use the search mode in Digital Micro-
graph (or TIA), otherwise the camera will be illuminated during 
each search process. If necessary, press "Stop-Viev" in DM. To 
be on the safe side, always close the screen quickly after each 
image.  

 In Digital Micrograph: Acquire with Exposure time 0.01 s (with 
Binning 1, which is set by default). Acquire an image, close the 
screen and read the max. intensity of this image. To do this, 
click on the captured image and call up the statistics under 
Analysis->Statistics->all and read off "Frame: Maximum...". 
The max intensity should not exceed 7.000. Now take some test images with higher times (up to 1 
s). If the intensity and the expo-sure time are well adjusted (good image at not more than 7,000 
max. intensity), then take and save the image. 

  

 

 

 Ready. Screen closed. Exit Diffraction mode. Beam stopper out.  SA aperture out.  
 

 
 
 
 
 
 
 
 
 
 
 

 

Turn here to bring the beam 
stopper in/out

On the right of the TEM column is the control for 
the beam stopper

Turn here to change the length 
of the beam stopper slightly.
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13. STEM  

Im STEM (=Scanning TEM) wird der Strahl punktförmig zusammengezogen und damit die Probe abge-
rastert (wie in einem REM). Vorteile gegenüber normalem TEM sind die Möglichkeit viel besserer 
Auflösung/Höhere Vergrößerung und besserem Kontrast. Nachteile sind aufwendigere Justierung des 
Strahls, aufwendigeres Scharfstellen für jedes Bild und höhere Strahlendosis auf der Probe, wodurch 
die Probe noch freier von Verunreinigung sein muss.     
 

Für STEM hat Nicholas Rudawski (Univ. Florida) ein sehr hilfreiches Video insbesondere für Halb-

leiterschichten gemacht: „FEI Tecnai F20 S/TEM: STEM mode operation“ auf Youtube  
 

 Die Probe sollte möglichst sauber sein. Neue Proben sind in der Regel sauberer als alte Pro-
ben. Ggf sollten die Proben gecleant werden mit dem Plasmacleaner.  

 Für STEM muss das zu betrachtende Probenmaterial im TEM oben liegen (umgekehrt wie 
beim normalen BF TEM-Modus)! Daher die Probe im Probenhalter nach unten einbauen, da 
der Stab dann noch um 180° gedreht wird. 

 Noch mal überprüfen, ob die Objective und selected Area Apertures wirklich raus sind (He-
bel nach rechts).  

 Probe in das TEM einschleusen  

 Euzentrische Höhe einstellen (euzentric fokus drücken, mit z die Höhe so verstellen, dass der 
Kontrast minimal wird). 

 Kristalline Proben: Mit double Tilt holder einschleusen und Zonenachse einstellen d. h. beide 
Winkel richtig kippen, so dass die Atome im Gitter „hintereinander“ im Strahl sind und durch-
scheint werden können. Dass nahe der Oberfläche, Area of Interest (wo man Messen will). 
Später muss man das im STEM noch mal genauer machen.   

 Condenser Apertur C2 auf Position 4 drehen und mir den beiden Reglern an der Blende 
mittig einstellen. Ggf. Astigmatismus der Condenser-Linse (Strahl nicht rund) korrigieren. (Be-
merkung: Später wird C2 auf Position 2 gedreht für die Messungen. Position 4 ist notwendig, 
um das Ronchigram richtig einstellen zu können) 

 Im BF TEM-Modus die euzentrische Höhe einstellen: Eucentric focus drücken, z-Höhe einstel-
len (Wie in normalen TEM). Dann am besten in Digital Micrograph mit der FFT die z-Höhe 
exakt einstellen, so dass man wirklich zu 100 % in der euzentrischen Höhe ist.  

 Dann mit Column ->Image Settings-> Reset Def. den Wert von Focus auf null setzen. (Dies 
macht man, damit man später noch diese Höhe wiederfindet.)  
 

 

 
 
 
 

https://youtu.be/JtVmDOa--gg
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 Schirm muss geschlossen sein! Kamera zurückfahren (DM -> Stop View & Camera inserted: 
uncheck)! Weil gleich mit STEM der Defraction Modus gestartet wird und der direkte Strahl 
sonst die Kamera beschädigen könnte.  

 FEG-Register für STEM laden (mit Extraction Voltage = 4500 V, Gun Lense = 6, Spot Size = 10 
und Nanoprobe mode). Jetzt ist man im STEM-Modus, difraction ist ON.  

 Eucentric focus drücken.  
 

 Wenn mit EDX gemessen werden soll (Optional) 
Jetzt kippen auf typisch Alfa = +20,0 °   ,  
Spotzise = 5 . Dadurch wird der Strahl größer, was mehr Counts gibt, aber auch gröber abrastert. Je 
nach Probe gehen auch andere Spotsize-Werte.  

 
 User interface: STEM:  HAADF-Detektor selektieren in "Stem detector(user)",  

 

Camera Lengh = 200 mm einstellen.  
 

 

 

 Magnification 40.000 x einstellen und STEM: Search anmachen. Mit Focus-Knopf scharf stel-
len und dann wieder Search stoppen.  
Kein Bild? 
-> HAADF-Detektor noch mal raus- und wieder reinfahren. 
-> „INT SCAN“ muss an der Box für das EDX gedrückt sein. 

 Ronchigram: Magnification 7000 x STEM. Kameralänge 200 mm. Ronchigram entweder am 
kleinem Schirm mit dem optischen Mikroskop oder im DM search modus anschauen. Eine 
Amorphe Stelle suchen (z. B. Kohlefilm bei TEM-Gritts, Kleber bei MBE-Proben). Den Wert 
der jetzige z-Höhe gut merken. Die Z-Höhe so verändern, das Ronchigram gut aussieht. Fein-
justage mit Fokus-Knopf. Ronchigram in die Mitte bringen mit „Differental Alignment“. Dann: 
Stigmator: Condensor und mit den beiden Multireglern das Ronchigram einstellen (wenn es 
nicht rund ist).  

 

Kein R. (Fokus falsch)     R. etwas Astigmatismus      R. optimal 
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 Strahl zu Alignen im Ronchigram:   

 Rotation Center (intensity):  Focus Step auf 4, dann Direct Alignment: Rotation center drü-
cken und am Focus Step drehen, bis das wobbeln aufhört. Jetzt am Focus hin und her drehen 
(manuell wobbeln) und mit den Multireglern gegensteuern, so dass das Rotation Center ein-
gestellt wird. Ronchigram soll konzentrisch expandieren und kontrieren.  

 Stigmator: Condenser 
 Die Mitte des Ronchigram mit Beamstopper markieren. Dann C2 auf Position 2 (oder gar auf 

1) stellen. Anhand des Beamstoppers jetzt die Blende Mittig einstellen. Beamstopper raus. 
Schirm ggf. schließen.  

 

 

 Tia STEM: search modus. 256 x 256 pixel, 1 sec frame time. Kameralänge 100 mm (oder gar 
50 nm) einstellen. Vergrößerung deutlich höher.  

 STEM: Search läuft. Alignment: difraction alignment und Multifunctionsregler centern. 

 Contrast und Brightness einstellen: Unter dem Histogramm ist ein Knopf, wo man Hell-Dun-
kel vertauschen kann (wer will). Mit Auto C/B versucht TIA, Contrast und Brightness automa-
tisch gut einzustellen. Mit Scope sieht man Contrast und Brightness und kann es mit den 
Multifunktionsreglern (in der Steuerung anklicken) einstellen bzw. mit der Maus auf die Reg-
ler klicken.  

 Noch mal Probe mit α und ß ausrichten: Schirm geschlossen, STEM ist an.  Beam Position 
Marker in TIA auf eine Stelle im Kristall nahe der Area of Interest. Am Schirm kann man dann 
an genau dieser Stelle das Difraction pattern sehen. Magnification erhöhen. An amorpher 
Stelle z. B. Kleber die Höhe in den euzentrischen Fokus bringen.  Jetzt iterativ: α und ß vor-
sichtig verändern und in den Pol bringen (Zone Axis Alignment), jeweils in TIA die Höhe korri-
gieren z.  

 Mit Focus und Stigmator:condensor scharf stellen. Stigmator Steuerung aufrufen und jetzige 
Werte in ein anderes Register kopieren, damit es nicht verloren geht. Drehen, so dass es 
schärfer wird.  

 Atomic Level: Magnification sehr hoch 1.8 Mio min, 5-7 Mx. Slowly focus mit Stig:condensor 

 Wenn alles gut aussieht: Bild aufnehmen mit Acquire.  
 Abspeichern der Bilder: Save as: *.emi file.  Die Bilder können dann mit TIA wieder geöffnet 

werden (gibt es im TEM-Vorraum auf dem PC dort) oder mit ImageJ (benötigt extra Plugin). 
In TIA kann man die Bilder exportieren mit: Rechtsklick auf Bild, export data: Save as: With 
Scale! Wichtig, sonst ohne Scale. Zb. JPG w/scale 

 Beenden: STEM aus, FEG register für TEM laden. Blende C2 wieder auf 3 stellen und mittig 
machen.  Dann wie bei TEM BF beenden. (Blenden raus, 4400 x magnification, reset holder, 
column valves schließen, Probe ausbauen, aufräumen, ggf. Cryo circle starten).  
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14. STEM-EDX 

 
 Wichtig: Das Programm „clmserver“ auf dem TEM Rechner muss gestartet sein. Dies ist in der 

Taskleiste sichtbar. Ist es nicht an, können die Daten (z.B. eingestellte Vergrößerung) nicht vom 
TEM an den EDX Rechner übertragen werden. Eine Fehlermeldung beim Starten der TEAM 
Software weist darauf hin. Dann „clmserver.exe“ manuell starten (C:\Edax32\IMG) und TEAM 
Software neu starten. 

 
 

 Proben, an denen EDX Messungen durchgeführt werden sollen, müssen sehr sauber sein und 
lange/hohe Strahlendosen aushalten können. Es empfiehlt sich dies zunächst durch Aufnahme 
eines STEM Bildes zu prüfen. Wenn hier schon eine Zerstörung der Probe oder Verbrennen 
von Verunreinigungen sichtbar ist, kann eine weitere Probenvorbereitung notwendig sein. In-
tensiveres Waschen (oder, wenn die Probe es zulässt, Plasma cleanen) kann Abhilfe schaffen. 

 
 Probeneinbau und Einstellungen wie in STEM beschrieben. Probenhalter muss auf ca. 20° ge-

kippt werden. Dabei gilt zu beachten, dass ein größerer Strahl (über Spotsize oder die C2 
Blende einstellbar) zu deutlich mehr Signal führen kann, aber entsprechend die Auflösung der 
Messung verringert. Dies muss von der Probe abhängig entschieden werden. 

 
 Edax-PC starten, Einloggen mit dem Passwort „apollo“, TEAM Software starten 

 
 In der TEAM Software anmelden, ggf. neuen User anlegen. 

 

 
 

 Neues oder existierendes Projekt auswählen und eine Probe anlegen. 
 

 Vor der Messung muss der EDX Detektor eingekühlt werden. Dazu auf rechts das Menü aus-
klappen und im Reiter „EDS Detectors“ auf die rote Schaltfläche „Cooling Off“ klicken. Diese 
wechselt dann zu gelb, „Cooling On“, und wird grün, wenn der Detektor bereit ist. Dies wird 
ebenfalls über das Thermometer-Symbol im Kasten unten rechts angezeigt und kann auch dar-
über gesteuert werden. Wenn der Status grün ist, kann der Detektor eingefahren werden. 
Dazu auf die Schaltfläche „Move In“ klicken oder auf den Pfeil (neben dem Thermometer im 
Kasten unten rechts) klicken. 
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 Das Bild des TEM ist immer nur auf einem Rechner verfügbar. Mit dem Kasten kann dies um-
gestellt werden zwischen Int Scan (Bild auf TEM Rechner/TIA Software) und EDX scan (Bild auf 
EDX Rechner/TEAM Software) 

 

 
 
 

In der TEAM Software: 
 

 Achtung auf ausreichendes Signal (cps). Die aktuellen cps werden unten links angezeigt. 

 
 
Wenn diese sehr gering sind: 

 Ist tatsächlich Probe im Strahl?  

 Ist der Probenträger gekippt (nötig sind Winkel 20-40°)? 

 Ist der EDX-Detektor an und reingefahren? 
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 Auswahl der Messung über die oberste Reihe. Es können reine Spektren („Spectrum Only“), 
Elementarverteilung in einem Bild („Mapping“) oder auf einer bestimmten Linie/Punkt („Line 
Scan“ bzw. „Point Analysis“) der Probe gemessen werden. Über „Multifield Analysis“ lassen 
sich mehrere dieser Operationen in einer Anweisung kombinieren. Im Weiteren wird ein Map-
ping als Beispiel beschrieben. 

 

 
 

 Vor der Messung ein Bild der Probenstelle aufnehmen. Dazu mit der Maus über den Reiter 
„Image Area“ gehen, hier lässt sich die Auflösung dieses Bildes einstellen und weitere fortge-
schrittene Einstellungen über die Schaltfläche „Advanced“ oder direkt im Menü an der rechten 
Seite. Durch Klicken auf den Reiter wird ein Bild aufgenommen. 

 
 Um die Abbildung der Probenstelle erscheint ein grüner Kasten. Mit diesem kann der Bereich, 

der untersucht werden soll, nochmals feiner eingestellt werden. 
 

 
 

 Zunächst wieder mit der Maus über den Reiter „Collect Map“ gehen. Einstellungen auf ma-
nual! Nur dies erlaubt das freie Einstellen der dwell time (Zeit die der Strahl an einem Mess-
punkt verweilt) und der frames (wie oft soll die Probe ab gerastert werden und die Messungen 
addiert). Zunächst mit sehr geringer Auflösung starten und diese dann anpassen. 

 

 
 

 Mapping durch Klicken auf den Reiter „Collect Map“ starten. Durch erneutes Klicken auf den 
Reiter wird das Mapping abgebrochen und im jetzigen Zustand gespeichert. 

 
 Hacken setzen bei „Elemente zuweisen“. Wenn das Mapping beginnt, die relevanten Elemente 

im angezeigten Periodensystem auswählen und bestätigen. 
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 Die Farbe, die für die Elemente verwendet wird kann über „Display Options“ -> „Assign Ele-
ment colors“ angepasst werden. 

 

 
 Nach dem Mapping steht auf dem Reiter „Finish“, durch Klicken auf den Reiter diese Proben-

stelle abschließen. 
 

 Die Messungen können zusammengefasst als pdf-Report (über Klicken auf den Reiter „Re-
port“) exportiert werden. Einzelne Bilder können über Klicken auf das Ordner Symbol an die-
sen exportiert werden. Dazu im Nutzer*innenprofil (durch Klicken auf das Profilbild oben 
rechts) die „custom image folder location“ angeben und das „send to folder filename format“. 
Die Bilder befinden sich dann im angegebenen Ordner in einem Unterordner benannt nach 
dem Projekt, mit dem entsprechenden Namen. 

 

 
 
 

 Am Ende: EDX-Detektor wieder rausfahren, Kühlung beenden, Programm TEAM beenden, 
Rechner runterfahren 
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Troubleshooting & Maintenance  

15. Known Problems & Solutions   

 Compustage zeigt rote Lampe zu Beginn der Session 

 Select „No Holder“ und Enter, dann sollte es gehen 

 Gatan Digital Micrograph will plötzlich keine Bilder mehr aufnehmen /Gibt unsinnige Fehlermeldun-
gen 

 Dann hat man vermutlich bereits viele Bilder gemacht. Die müssen geschlossen werden. Dann 
sollte es wieder gehen. Die vielen Bilder nehmen zu viel Platz im Arbeitsspeicher weg.  

 Auf allen Bildern sind immer an der gleichen Stelle komische Flecken oder ein Intensitätsverlauf von 
einer Seite zur anderen 
Die Gain-Referenz der CCD- Kamera muss neu gemacht werden => Den TEM instrument officer infor-
mieren.  

 Vakuum Einbruch beim Probe-Einschleusen 
Wenn beim Einbringen des Probenhalters das Column-Vakuum einbricht, dann: 

 Dem TEM instrument officer Bescheid geben. Wenn der nicht kann, dann kann man versu-
chen:   

 Probenhalter vorsichtig entfernen 

 Ausloggen 

 Als Supervisor einloggen (siehe kleines TEM-Buch am TEM für Username und Password) 

 Microscope interface starten 

 Vakuum Übersicht öffnen 

 Vakuum -> Flapout -> Vakuum „to Ready State“ knopf drücken. Diesen Knopf hat man als nor-
male Nutzerinnen bzw. normaler Nutzer nicht. 

 Warten, bis das Vakuum wieder normal ist. 

 Den Vorfall im Logbuch notieren.   

 Software Absturz 
Wenn die Software abstürzt: Software neu starten. Evtl. muss mit dem Task-Manager ESVision.exe 
vorher beendet werden.  

 Bild wackelt plötzlich periodisch 
Vielleicht ist die Compustage abgestürzt. Dann kann man z. B. keine Track-Punkte mehr setzen. => Pro-
benhalter ausbauen. Compustage neu starten (Compustage flapout letzer Reiter auf Enable aus und 
wieder anmachen. Die Compustage kalibriert sich neu. Dauert ca. 5 Minuten)  

 Wasserkühler in Störung 
Einmal aus- und wieder an machen (linke Taste) am Kühler. Ggf. etwas Wasser nachfüllen, so dass das 
Wasser 1 cm unter den Rand gefüllt ist.   

 Steuerpanel ausgefallen 
Das Steuerpanel am Steuerrechner (USB an der Rückseite) aus und wieder einstöpseln.  Evtl. ist dann 
noch ein falscher Steuerbefehl irgendwo im Programm. Dann muss (sowas darf nur der TEM instru-
ment officer) der TEM-Server neu gestartet werden und ggf. sogar der TEM-Steuerrechner ganz neu 
gestartet werden. Vorher FEG in Standby schalten und HT ausmachen.  

 Probe sehr lange „unruhig“, so dass keine Bilder aufgenommen werden können 
Tipp: Vorsichtig auf die Rückseite des eingebauten Probenhalters klopfen.  

 Die neu eingebaute Probe ist nicht in die Euzentrische Höhe zu kriegen, da diese „Out of Range“ liegt
  

 Ist bisher einmal aufgetreten: Die kleine Halterung an der Spitze des Probenhalters 
hatte sich um 180 Grad umgedreht. Lässt sich vorsichtig zurückdrehen.     

 Steuerrechner stürzt ab oder „friert ein“ beim Ausloggen  
Wenn das passiert, muss der Steuerrechner neu gestartet werden. Leider muss dann auch der das Pro-
gramm „TEM-Server“, das Vakuum, die HT und evtl. die FEG neu gestartet werden. Bitte den TEM in-
strument officer das machen lassen.   
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16. Restart TEM Server  

 
Wenn der Steuerrechner neu gestartet werden musste, ist dies notwendig. Dieser Schritt steht in keiner Anlei-
tung von FEI.  
 
 

 
 

 
 

 
 

 
 
Fertig! Dann das TEM User Interface öffnen, um das Vakuum zu starten. Vakuum-ON Knopf am Panel (Box) 
drücken.  
 
 

 
 

Um den TEM-Server zu starten, 
muss das kleine Ikon rechts un-
ten angeklickt werden  
 
 
 
 
Start -> Microsope -> TEM selek-
tiert  
 
 
 
 
Dann einfach warten, bis das 
TEM-Symbol auftaucht 
 
…..sich aufbaut und grün wird 
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17. Restart FEG and High Tension 

Da die Hochspannung (High Tension = HT) und die Feldemissionskathode (Field Emmission Gun = 
FEG) leider des Öfteren ausfallen, ist hier eine Kurzanleitung, diese wieder zu starten. Prinzipiell soll-
ten FEG und HT vorsichtig d h. nicht zu schnell gestartet werden, sonst kann es zu elektrischen Über-
schlägen kommen, die wiederum das TEM schädigen könnte.  
  

 Im ersten Reiter des Menüs (Setup) sind die Steuerungen für High Tension und FEG. Hier 
jeweils das Untermenu ausflappen (siehe Bild) 

 

So sieht es aus, wenn FEG und HT komplett ausgefallen sind.  
 

 Die FEG starten: 
 Power starten (falls Power aus ist). Wenn nur die HT ausgefallen war, dann ist Power 

noch an. Wenn Power neu gestartet werden muss, dann erscheint im FEG Menu der 
Hinweis "Status: Waiting for FEG IGP to start up". Das kann etwas dauern…Dann er-
scheint "Status: Ready for Warm/Cold Start" und es kann weitergehen. 

 Wenn die FEG länger als 48 Stunden aus ist, dann Cold Start drücken. Sonst mit Warm 
Start starten. Wenn man sich unsicher ist, wie lange die FEG aus ist, dann im Anlagen-
buch nachschauen. Cold Start dauert 90 mins, Warm Start dauert 27 mins.   

 

FEG starten: Entweder mit Cold Start oder mit Warm Start.  
 

 Dach ist die FEG an: Operate, Power und FEG-Knopfe sind an.  
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 HT Starten: 
 Wenn die FEG an ist, aber der Knopf „High Tension“ noch grau und nicht drückbar ist, 

dann muss VAC am Control Panel (kleiner Kasten) gedrückt werden.  
 0-20kV: High Tension Knopf drücken bei Ziel: 20 kV. Die High Tension wird jetzt relativ 

schnell auf 20 kV geladen (siehe Measured HT). 

 

Ziel 20 kV, High Tension drücken 
 

 20kV-160kV: "Free high tension" anklicken und Schritte 10.000 einstellen, und dann in 
10.000ern Schritten die HT langsam erhöhen. Hierbei die "Measured HT " beobachten 
und immer einen 10.000ern Schritten machen, wenn die Measured HT nahe dem Ziel-
wert kommt.  

 

 
 160kV-190kV:  "Free high tension" + Schritte 3.000 einstellen und in 3.000ern Schrit-

ten die HT langsam erhöhen. Hierbei die "Measured HT " beobachten und immer ei-
nen 3.000ern Schritten machen, wenn die Measured HT nahe dem Zielwert kommt.  

 190kV-200kV:  "Free high tension" + Schritte 1.000 einstellen 
 HT auf 200 kV: Das Häkchen bei "Free high tension" entfernen. Die beiden Unterme-

nüs von HT und FEG können wieder zugeflappt werden.  
 HT und FEG sind an. Der FEG-Strom steigt noch ca. eine Stunde, aber es kann schon gearbei-

tet werden. Den HT-Ausfall und Neustart in das Anlagenbuch eintragen.  
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18. Set up new TEM user on TEM control computer  

 Neuen Windows-User anlegen 
Als Supervisor einloggen (Siehe Rotes Buch am TEM) 
Start -> Programs -> Administrative Tools -> Computer Management 
Local Users and Groups -> Users 
Rechtsklick und "New User" 

User Name: <Nachnahme> 
Fullname: Vornahme + Nachname 
Description: Z.B. Doktorand*Inn Institutskürzel Professor*In 
Passwort: wie immer, sollen die Leute dann ändern 
Check-Box: "Password never expires" 
Create! 
Neuen User anklicken und Rechte vergeben: 
Doppelklick auf den User, Reiter "Member of" 
Add: Administrators, TEM Experts, Power Users 
(Jeweils Objekt-Name einfügen und Check Names drücken, mit OK bestätigen) 

 TIA Rechte 
Als Supervisor  
Programs -> FEI Company -> TIA -> TIA User Administration 
User -> Add User 
<Nachnahme> Eingeben, Checkbox "This is an administrator", und OK, "Create Directoy?"YES 
Fertig 

 Mouse Without Boarders 
Ab hier als der neue User einloggen   
Das Logo ganz rechts unten anklicken 
Passwort ändern zu: TECNAI200 
Aply and Close 

 Shortcuts anlegen 
Es sollen drei Shortcuts auf dem Desktop erzeugt werden: Jeweils im Datei-Explorer suchen, 
rechtsklick, Create Shortcut, auf den Desktop verschieben und ggf. umbenennen. 

a. C:Tecnai\Exe\Peoui.exe , "TEM User Interface" 
b. C:Program Files\Gatan\Digital Micrograph. "Digital Micrograph" 
c. C: Program Files\FEI\TIA\bin\ESVision.exe, "TIA 

 Cryo Circle 6 Pumpzeit 
TEM userinterface starten 
Setup -> Vakuum -> Flapout: Cryo und "Start After: 7 min" eintragen, kleines Return-Zeichen 
dort drücken für Eingabe. 
Ebenso einstellen: Pumpzeit 180 s.  

 DM auf zweiten Bildschirm 
Alle drei Programme starten 
Beim kleinem Menue rechts unten im TEM Userinterface auf das blaue Quadrat klicken 
Bei erscheinenden "Aplication Selection" auf das <> Symbol klicken 
Select application: Digital Micrograph, Check "put on 2nd monitor" und aply drücken 

 EDX vorbereiten  
Startup -> Shortcut to clmserver.exe reinkopieren. Das liegt in: c:\Edax32\IMG 
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 Verbindung mit dem Datenlaufwerk vom TEM-Rechner 
 Im Netzwerk gibt es das Laufwerk „TEM Bilder“ für die TEM-Nutzer*innen 
 Verbindung herstellen mit: Explorer öffnen, Tools -> Map Network Drive 

 

Dort bei Folder eingeben: \\10.74.134.188\TEM Bilder  und Finish drücken 
 

 
Dann muss man sich einmalig anmelden: User Name: TEM, Password: benutzer39  
Checkbox an bei „Remember my Password“ 

 
Dann ist man auf dem Laufwerk TEM Bilder   
Dort im Verzeichnis „Nutzer“ einen eigenen Ordner <Nachname> anlegen. 

 
 
 
 

TEM Bilder 
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 Workspace Layout 
Beim kleinem Menue rechts unten im TEM Userinterface "Workspace Layout" selektieren 
Screenshots des Standart-Layouts sind in TEM Bilder:Nutzer\FSW. Entsprechend das Layout 
editieren 
 gewünschte Dinge von rechts nach links in die Ordner ziehen 
 Zum Löschen Dinge rausziehen 
 Ordner umbenennen  
 Ordner Kopieren für neue Ordner 

Dann noch die Anzeigen Unten im TEM Userinterface editieren (Object Lese und Defocus 
hinzu)  
 

 FEG Register 
Setup -> FEG Register -> Flap Out: File Open.  
Das Register von FSW laden: usr_FSW.feg 
Das zuletzt gespeicherte FEG-Register für TEM laden (Selektieren und Set drücken. Dafür ggf. 
die FEG in Operate schalten und danach wieder aus). 
Ausloggen (NICHT herunterfahren). Fertig 

 
 Verbindung mit dem Datenlaufwerk von der LNQE-Domain 

Auf einem Rechner in der LNQE-Domain einloggen (z. B. dem Rechner im Vorraum beim 
TEM) 
Datei-Explorer öffnen, Dieser PC mit rechter Maustaste anklicken, dann Netzlaufwerk verbin-
den… anklicken 

 
  

Dort Ordner: \\10.74.134.188\TEM Bilder  eingeben.  
Checkbox an bei „Verbindung bei Anmeldung wiederherstellen“ 
Fertig stellen klicken. 
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Da ist jetzt das Laufwerk „TEM Bilder“ 
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19. Recalibrate Camera References    

Typ: Gatan Orius SC 1000 CCD.  

 Alle Referenz-Files vorher sichern 
 Die Refs liegen in: c:\program files\Gatan\DigitalMicrograph\Reference Images 
 Die Files dort kopieren und in einem neu anzulegenden Verzeichnis im Unterordner „Backup Refe-

rences“ speichern 
 

 

 
 Strahl vorbereiten 
Probenhalter ohne Probe einbauen 
C2 mittig einstellen 
Direct Allignments 
Typische Vergrößerung (135 kx) 
Ein Bild mit Digital Micrograph aufnehmen zum späteren Vergleich (Bei ungleicher Intensität bei 
gleichzeitiger mittiger Ausleuchtung bedeutet, die Kamera muss in der Tat kalibriert werden) 
 

 Dark Referenz 
Schirm geschlossen, Colum Valves closed, Schwarze Plastik-Abdeckung drauf, alles dunkel (so gut 
es geht 
Digital Micrograph -> Camera -> Prepare Dark Reference  
Starten! Alle Fragen etc. mit yes beantworten 
Es werden 3 Images aufgenommen mit je 20 Aufnahmen + 8 kleine (ein streifiges Bild). Dauert ca. 
7 Minuten.  

 Gain Referenz 
Strahl an und 4 cm Kreis gut ausleuchten (d. h. 1 cm drüber)  
Typische Vergrößerung (135 kx) 
Testen: Intensity im Uhrzeigersinn drehen vergrößert den Strahl  
Schirm auf, Abdeckung drauf, Licht aus 
Digital Micrograph -> Camera -> Prepare Dark Reference  
Testbild aufnehmen 
Digital Micrograph -> Camera -> Prepare Gain Reference  
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Einstellen: Target intensity: 3000 und Frames to average: 10 
Starten! Alle Fragen etc. mit yes beantworten 
Es werden wieder diverse Bilder aufgenommen, dauert ca. 5 Minuten 
Evtl. ist zwischendurch die Intensität zu hoch, dann muss man vorsichtig den Fokusknopf im Uhr-
zeigersinn drehen, bis die Kamera wieder „im grünen Bereich“ ist und dann Proceed drücken 
 

 

 
 Test Bild 

Ein letztes Testbild machen. Wenn es jetzt gleichmäßig ausgeleuchtet ist, dann hat die Kalibrie-
rung gut funktioniert 
Troubleshooting: Sonst die Referenzen noch mal aufnehmen; wenn das nicht klappt, kann man 
nur alte Referenzen laden.  
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20. Change of an Aperture 

 Blenden sind aus Platin-Legierung, 3 mm rund, Dicke? 
 Gasförmigen Stickstoff anschließen am Wasser-Reck (steht dran) 
 Schon mal an der Blende vorsichtig aufdrehen, damit kein Überdruck entstehen kann 
 Druck P2 merken (z. B 2E-7) 
 Column fluten mit Stickstoff. Dafür das Programm: Tecnai TF20 Vacuum Control nehmen  

c:tecnai\exe\service\tstmdvakuum.exe 
 Blende losschrauben, vorsichtig rausziehen. Spezialschraubendreher liegt im Schrank ir-

gendwo 
 Handschuhe, Arbeitstisch mit Allufolie auslegen 
 Die jeweils 4 Blenden kann man vorsichtig eine nach dem anderen aus der Halterung ent-

nehmen. Dabei darauf achten, wie rum die waren (!!!) 
 Neue Blende und die anderen wieder einbauen mit einer Pinzette 
 Wieder in die Column rein, alles zudrehen 
 Im Vakuum-Programm alles evakuieren (einige Stunden, über Nacht), bis P2 wieder so 

wie vorher 
 Dann „Evakuate all“ im Programm drücken, so das normaler Vakuumzustand erreicht 

wird  
 Blende justieren (kleine Vergrößerung)    
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21. Maintenance 

Monatlich 

 Überprüfen der Drück von SF6 am Tank (Typisch 4,5 Bar, darf nie weniger als 4,0 Bar sein) und am TEM 
(etwas mehr als 6 Bar, siehe Markierung).  

 Überprüfen der Wasser-Durchflüsse, die zwischen den Markern sein sollten (auf 42 ml/h). Überprüfen, 
ob es Algenbildung gibt (dann ggf. Thermoclean nachfüllen) 

 Kühlwasser nachfüllen. (Normales Wasser) 

 Blick auf die USV 

 Nach Wasserlecks gucken. 

 TEM abstauben, Trackball rausnehmen (gegen den Uhrzeigersinn drehen zum öffnen) und alles säu-
bern.  

 Bufferung des TEMs kontrollieren durch Gegendrücken.  

 Kleines Lichtmikroskope am TEM: Schrauben festziehen.   

 Rarely (every three months): Probenhalter mit Isopropanol reinigen und Dichtringe fetten. 

 Gain & Dark-Reference der CCD- Kamera neu kalibrieren.  

 

Selten 

 1-2-mal im Jahr Thermoclean Blue 7 ml ins Kühlwasser geben. Wasser auffüllen.  

 Das große Zahnrad in der Compustage fetten (mit Molikote BR-2 plus) ca. alle vier Jahre. Altes Fett ab-
wischen und neues Fett drauf; wenig Fett. Nach dem Zusammenbau testen, ob sich die Compustage in 
alle Richtungen bewegen lässt. Am besten von Thermo/FEI machen lassen.    

 Batterien für die Messung des Beam-Current wechseln. Ist nötig, wenn die Exposure Time falsch an-
zeigt.  
Dazu: 3 Schrauben am Tisch lösen, Tisch vorsichtig gerade nach vorne rausziehen. Kasten Links öffnen. 
Dann kommen 30 x LR44 Knopfzellen (1,5 V Alkaline) rein (Umbau von Oliver Kerker).  

 Am Ende des Jahres: Daten Sichern auf Backup-Platte.  

 Staubsaugen und ALLES abwischen 

 Kappe der Compustage reinigen 
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More Information 

22. Contact information  

Leibniz Universität Hannover 
Laboratorium für Nano- und Quantenengineering 
Schneiderberg 39, 30167 Hannover, Germany 
Website: www.LNQE.uni-hannover.de  
Telefon Sekretariat:  +49 511 762 16017, Fax: +49 511 762 16099 
Gebäudenummer: 3430 

Geschäftsführer &     Technischer Leiter &  
TEM Equipment Officer:      Strahlenschutzbeauftragter: 
Dr. Fritz Schulze-Wischeler    Dipl. Ing. Oliver Kerker  
Telefon: +49 511 762 16014    Telefon: +49 511 762 16016  
Schulze-Wischeler@LNQE.uni-hannover.de   Oliver.Kerker@LNQE.uni-hannover.de   

LNQE-Notfallnummer: 0160 4327077 

E-Mailverteiler an alle TEM- Nutzer*innen: TEM-Nutzer@LNQE.uni-hannover.de  

23. Features of the TEM  

Das TEM im LNQE hat eine Beschleunigungsspannung von 200 kV und als Elektronenemitter eine Feldef-

fektkathode. Wichtigste Paramater sind: 

 Gerätetyp: TEM Tecnai G2 F20 TMP von Fa. FEI 

 200 kV Feldeffekt FEG 

 Ölfreies Vakuum 

 TEM point resolution: 0,27 nm 

 Information limit: 0,14 nm (gemessen!) 

 STEM resolution: 0,24 nm 

 1 Hellfeld- und 2 Dunkelfeld-Detektoren +1 HAADF-Detektor 

 Tomografie ± 70°(Theoretisch bis zu ± 80° mit besonderen Halter)  
Mit diesem TEM sind alle klassischen Kontrastverfahren möglich: Hellfeld und Dunkelfeld, Beugungskon-
trast (einschließlich Weak-beam), parallele Beleuchtung bei alle Vergrößerungen (wichtig insbesondere bei 
der Untersuchung kristalliner Proben), TEM und STEM (scanning TEM). Dabei sind große Kippwinkel mög-
lich. Eine Besonderheit des TEM ist die Möglichkeit der Tomografie. 

 

24. Book a Session  

 Eine Session kostet 220 Euro.  

 Über folgende Adresse kann man sich im Online Web App (OWA) des LNQE einloggen: 
https://owa.lnqe.uni-hannover.de/owa/  
Dies ist eine sichere Verbindung. Ggf. muss man „Erweitert“ „Ausnahmen hinzufügen“ „bestätigen“ 
drücken.  

  Dort ist man am Anfang bei den E-Mails und muss in die Kalender wechseln (Links Oben) 

 

http://www.lnqe.uni-hannover.de/
mailto:Schulze-Wischeler@LNQE.uni-hannover.de
mailto:Oliver.Kerker@LNQE.uni-hannover.de
mailto:TEM-Nutzer@LNQE.uni-hannover.de
https://owa.lnqe.uni-hannover.de/owa/
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 In den Kalendern muss man einmalig den TEM-Kalender hinzufügen mit Rechtsklick auf „Kalender von 
Person“ auf der linken Seite-> „Kalender öffnen“ und dann eintragen „TEM Tecnai“ und mit OK bestä-
tigen.  

 Im TEM-Kalender kann man jetzt die gewünschte Session buchen.  

o Session 1: 8.30 – 13:00 Uhr 

o Session 2: 13:00 – 17:30 Uhr 

Doppelklick in das Feld mit dem gewünschten Tag und den neuen Termin eintragen. Bitte immer den 
eigenen Namen, die Bezeichnung des Instituts und den Namen des/der Professors/in, Gruppenlei-
ter/in etc. angeben, der/die die Rechnung für die Session erhalten wird.  

 

   

 

Eigener Namen, In-
stitutskürzel, Rech-
nungsempfänger

Zeitraum:   
Session 1: 8.30 – 13:00 Uhr 
Session 2: 13:00 – 17:30 Uhr 

Zum Schluss: Speichern und schließen 
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25. Analysis Software 

 
 
Gatan Digital Micrograph  
 
https://www.gatan.com/installation-instructions  
 
 
ImageJ  

 
Mit der Free-Ware ImageJ lassen sich die dm3-Dateien von Digital Micrograph und die ser-Dateien von 
TIA  öffnen und bearbeiten. 
Installation:  

 ImageJ herunterladen von: http://imagej.nih.gov/ij/   (Meist der erste Treffer von Google für ImagJ) 

 Download -> Windows –> bundled with Java (neuste Version)  

 Das zip-File entpacken in einen Unterordner des eigenen Home-Verzeichnisses 

 Die Datei ImageJ.exe startet das Programm. Wer will, kann sich eine Verknüpfung von ImageJ.exe 
auf den Desktop erstellen.  

 Für TIA-Bilder (STEM) muss noch ein extra Plugin installiert werden: TIA_Reader.jar. Hier runterla-
den: http://rsbweb.nih.gov/ij/plugins/tia-reader.html und in den Ordner Plugins/Jars kopieren. In 
ImageJ: Dateien öffnen mit Plugins->Input-Output-> Tia Reader. Dort den *.ser File öffnen.  
 

Wichtige Funktionen: 

 Achtung: Wenn man was in den dm3-Dateien geändert hat, dann bleibt die Änderung drin (schlecht 
für eine weitere Nutzung). Deshalb entweder mit einer Kopie arbeiten oder nur Bilder mit „Save as“ 
speichern und das Original dm3 unverändert lassen.  

 Undo: Steuerung +z (nur ein Schritt zurück ist möglich)  

 Measure: Steuerung +m 

 Skale-Bar einblenden: Analyze -> tools -> Scale Bar 

 DM3 –Datei laden und dann das Bild mit File->Save as in einem anderen Format (z. B.) jpg abspei-
chern 

 FFT: Bild anklicken, Shift gedrückt halten und ein Rechteck aufziehen (des zu analysierenden Berei-
ches). Dann Process->FFT->FFT klicken für Fourier-Transformation.  Dann interessierenden Bereich 
auswählen (Rechteck), Image - > Crop. Dann: Analyze -> Set Scale und in „unith of length“  statt nm 
dann 1/nm reischreiben. Mit Analyze -> tools -> Scale Bar erhält man nun einen Scale Bar in 1/nm.   

 Eine Kurzanleitung gibt es auf: http://imagej.nih.gov/ij/docs/pdfs/ImageJ.pdf  

 Tutorials and Examples gibt es auf der ImageJ-Website: http://imagej.nih.gov/ij/docs/examples/in-
dex.html  

 
 
 
 

 
 
 
 
 
 
 

https://www.gatan.com/installation-instructions
http://imagej.nih.gov/ij/
http://rsbweb.nih.gov/ij/plugins/tia-reader.html
http://imagej.nih.gov/ij/docs/pdfs/ImageJ.pdf
http://imagej.nih.gov/ij/docs/examples/index.html
http://imagej.nih.gov/ij/docs/examples/index.html

